
 

             Quick Setup Guide V1.2.1 

 

Introduction 

 

The quick setup guide is intended to provide information required to get most basic 

setups up and running using either the PiMPx or PiMPxs ECU. If you plan to use a non 

OE ignition system or advanced features, please refer to the attached MS3 Setup guide. 

Tables 1 and 2 located in Appendix A lists all PiMPxs ECU pins, and their Megasquirt 3 

functions, as well as the functions of all of the pins in the internal expansion connector 

that can be used for non plug and play features.  

 

Prior to moving forward with installation, it is highly recommended you copy the entire 

contents of  the provide USB thumb drive locally to your personal computer. This way 

you will always have a second copy of all startup information accessible on your PC, and 

you can keep your USB thumb drive in a “safe” place so it is only used as a backup to 

recover the startup files if necessary. 

 

If you have any questions, do not hesitate to use the PiMPxs support forum HERE. 

You have to register to view/use the forum.  

 

This forum is monitored by PiMPxs tech support specialists 20 hours a day, and is 

your best source for tech support. Only the support staff answers questions. It is 

recommended you register prior to beginning installation so you don’t have 

anything preventing you from asking questions if they arise.  

 

After you are running you will likely want to check out the Tuning guides located 

near the top of the PiMPxs section of the support forum. 

 
 

http://stinger-performance.proboards.com/board/16/pimpx-pimpxs-tech-support-tuning


Hardware Quick Setup 

1) Remove OE ECU, you’ll need a 10mm socket to remove the harness from the ECU. The ECU is 

located behind the passenger side kick panel on Fox Body vehicles (Mustang, Thunderbird, 

Cougar, Mark VII, etc.), behind the glove box in Merkurs, and mounted in the firewall in 

Rangers and F150’s. 

2) Connect supplied MAP hose to manifold pressure source. This pressure tap must be connected to 

a post throttle body pressure source (it must see both vacuum and boost). The vacuum tree or 

intake manifold are the best options. Route the supplied hose to the stock ECU location. Easiest 

way is to poke a small hole in the rubber surrounding the wiring harness where it runs through 

the firewall to the ECU. If your application requires a longer hose than typically supplied with 

the kit (6’), request a longer hose, do not source hose from a parts store. The stiffness of this hose 

has a surprisingly large effect on MAP sensor behavior and softer hose will negatively impact 

engine performance and tunability. DO NOT route near exhaust or you’ll melt the hose. 

3) Prior to installing PiMPxs ECU, install the required internal jumpers for the application. All plug 

and play setups will require the “Dist in”/JP2 jumper. See Appendix A for jumper functions. 

Only install jumpers required for engine operation at this time (ignition pull up, injector jumper, 

and cooling fan if required). All setups require jumpers and they are not pre-installed so don’t 

assume you don’t need jumpers for your configuration. 

4) Plug the factory ECU harness connector into the PiMPxs ECU. Connect the supplied hose to the 

MAP sensor port and secure with zip tie (used as a hose clamp). 

5) Install the new PiMPxs ECU in the factory hanger, plug in tuning USB cable, and secure PiMPxs 

with factory ECU hanger screw. 

6) Remove factory air meter/airbox assembly (MAF/VAM) and install a cone filter in its place. 

This is not necessary on speed density 5.0 cars.  

7) Unplug the factory BAP/MAP sensor and remove it if you want a cleaner look. 

8) If originally equipped with a P series ECU (83-86 Turbo Coupe, 4 cylinder Mustang, or any year 

XR4Ti), an ACT (air charge temp) aka IAT (intake air temperature) sensor must be installed. See 

Appendix B for installation of air charge temp sensor using factory VAM electrical connector. 

9) Note that certain applications such as 94-95 V8 Mustangs require minor re-pinning of the 

harness at the ECU connector to convert it to the A9L style V8 pinout This information can be 

found in the FAQ thread pinned near the top of the support forum here: HERE 
 

http://stinger-performance.proboards.com/post/46142/thread


Wideband Hardware Setup 

While not completely necessary, it is HIGHLY recommended a wideband o2 sensor and controller is 

installed and connected. It is true that skilled (or lucky) individuals tuned engines for decades just fine 

without them (because they weren’t available), but most of us do not possess this skill. The auto-tune 

feature will not work without a wideband signal. We sell the Spartan 2 wideband controller, sensor, and 

optional gauge that were designed specifically for ECU’s like ours both individually and in kit form on 

our site, listed below the ECU’s. For the most accurate AFR data being sent to the ECU, we suggest our 

kit. If you already have another brand though it will likely work. Refer to your wideband manufacturer’s 

instructions for installation specifics and troubleshooting when using another brand of wideband 

controller. 

 

The oxygen sensor input of your new ECU is connected to the factory EEC o2 sensor wiring (pin 29 for 

single sensor – passenger side on dual exhaust V8’s). Any aftermarket wideband controllers with a 0-5v 

linear output will work. You have two options to connect your wideband sensor to this pin: 

 

If you prefer wiring connections be made completely under hood, an adapter harness can be made by 

cutting the pigtail off an old factory O2 sensor (See Picture & Description Below). 

--In order to avoid modifying the factory harness and making the install completely reversible, you can 

cut the short wiring harness off of the stock o2 sensor and wire the wideband to it. This will allow you to 

plug the wideband into the factory o2 sensor connector and if you ever go back to stock, you can unplug 

the wideband and plug in a new o2 sensor right into the factory harness without any wiring mods.  

 

Most 4 wire o2 sensors have 12v, power ground, heater ground, and the signal to the ECU at this factory 

connector. 3 wire sensors are missing the signal (analog) ground. If your wideband has a separate signal 

(analog) ground & power (heater) ground, tie the signal (analog) 

ground to either signal return (pin 46), case ground (pin 20), or 

clean under-hood sheet metal.  

Do not connect power (heater) ground to signal return (pin 46) 

under any circumstances.  

 

Using stock o2 sensor connector (no harness modification): 

 

Spartan 2 Wideband in 86-93 Mustang:  

3 wires are available at the stock o2 connector. Wire colors: 

Spartan Color → Harness Color → Wire Purpose 

Red 12v → Grey/Yellow → Keyed 12v Power 

Green Signal Out → GRN/PPL or Grey/Lt Blu → Pin 29 Signal 

Black Signal GND → Tie to same wire as White below (or Pin 46 or 20 if wiring to ECU) 

White HTR GND → BLK/Lt GRN or BLK/WHT → Pin 40/60 (Power Ground) 

 

Spartan 2 Wideband in SN95 Mustang:  

4 wires are available at the stock o2 connector. Wire colors: 

Spartan Color → Harness Color → Wire Purpose 

Red 12v → Grey/Yellow → Keyed 12v Power 

Green Signal Out → Grey/Light Blue → Pin 29 Signal 

Black Signal GND → Grey/Red → Pin 46 (Signal Return) 

White HTR GND → Black → Pin 40/60 (Power Ground) 

 

Just to be sure, it’s best to test this with a multimeter to verify the wires you’re trying to use have 

continuity to the right pin or are keyed power, ground, etc. If your colors don’t match then you’ll have to 

do this as there is no other way to ensure proper connection. 

 



If you would rather connect Wideband inside the car near the ECU (Cut/Modify Harness):  

 

Red 12v → Keyed 12v Power 

Green Signal Out → Pin 29 Signal (Also Tied to Solid AFR Digital Gauge) 

Black Signal GND → Pin 46 (Signal Return) or Case Ground Terminal 

White HTR GND → Pin 40/60 (Power Ground) or Chassis Ground 

 

Cut pin 29 approximately 6” from the ECU (allowing enough wire to return to stock later if desired), 

and connect this 6” pigtail coming from the ECU to the wire listed above. The rest of the wires are not 

cut because they are shared with other sensors so you’ll “T” into them so they remain connected as-

stock and you’re just sharing the ground wires. Crimp or solder these connections.  

 

When using our Spartan2 Wideband o2 Controller with our Solid AFR Digital Gauge, note it ties into 

the same Green Spartan 2 wires as goes to pin 29 at the ECU. So there are 2 wires connected to the 

Green Spartan 2 wire when the gauge is used.  
 

Dual Exhaust Wideband Hardware Setup 

When installing the wideband in a vehicle with factory dual exhaust, pin 29 is for the passenger side o2 

sensor wiring. If you only have one wideband and dual exhaust, it is suggested that you test the air/fuel 

ratio readings in both sides of the exhaust. This is to find which side reads leaner (caused by variances in 

fuel injector flow, uneven intake flow, uneven head flow, or uneven exhaust flow). You’ll want to leave 

the wideband in the side of the dual exhaust that reads leaner for tuning purposes. This is so the “leaner” 

side is tuned to a safe air/fuel ratio and the “richer” side is simply slightly richer (safe) rather than tuning 

from the side that reads richer and having the other side be lean (not safe). 
 

If you wish to use dual widebands, the driver’s side o2 signal terminates at EEC pin 43. The PiMPxs is 

setup to accept a second o2 input on pin 43. See Table 1 for required jumpers. All wideband controllers 

in use must be of the same type/calibration. 

USB Setup 

To install USB drivers for an FTDI device to allow the ECU to communicate with your computer 

running Windows 7, Windows 8, or Windows 10, connect the device to a spare USB port on your PC. If 

there is an available Internet connection, Windows will silently connect to the Windows Update website 

and install any suitable driver it finds for the device. If the automatic installation takes place and says the 

device is ready to use, there is no need to continue with the procedure outlined below.  

 

If you don’t have an internet connection available or the driver fails to automatically update properly, 

follow the driver installation instructions for your operating system below (also found on the supplied 

USB thumb drive in the “USB Driver & Instructions” folder). Once the USB drivers are installed and 

working with no errors, proceed to the TunerStudio Configuration below. You cannot proceed if this is 

not working. In that case consult the PiMPxs Support Forum HERE 

 

Windows XP: Windows XP FTDI USB Driver Installation Guide 

Windows 7: Windows 7 FTDI USB Driver Installation Guide 

Windows 8: Windows 8 FTDI USB Driver Installation Guide 

Windows 10: Windows 10 FTDI USB Driver Installation Guide 

Driver Installer: FTDI USB Windows XP, 7, 8, 10 Driver Installer 
 

 

http://stinger-performance.proboards.com/board/16/pimpx-pimpxs-tech-support-tuning
http://www.ftdichip.com/Support/Documents/AppNotes/AN_104_FTDI_Drivers_Installation_Guide_for_WindowsXP(FT_000093).pdf
http://www.ftdichip.com/Support/Documents/AppNotes/AN_119_FTDI_Drivers_Installation_Guide_for_Windows7.pdf
http://www.ftdichip.com/Support/Documents/AppNotes/AN_234_FTDI_Drivers_Installation_Guide_for_Windows_8.pdf
http://www.ftdichip.com/Support/Documents/InstallGuides/AN_396%20FTDI%20Drivers%20Installation%20Guide%20for%20Windows%2010.pdf
http://www.ftdichip.com/Drivers/CDM/CDM21216_Setup.exe


TunerStudio Configuration 

The TunerStudio tuning software needs to be properly configured for your setup before usage. Start by 

installing TunerStudio using the installation file on the USB thumb drive. Once it is installed, open 

TunerStudio. Allow it to update when prompted to do so (if connected to WiFi). If you purchased a 

TunerStudio license you should register it at this time (following the directions on the supplied USB 

drive), and then connect the laptop to the PiMPxs by plugging in the USB cable directly into the 

PiMPxs. Now turn the vehicle’s key to run (not start) so the PiMPxs will be powered up. You should 

hear the fuel pump run for 2 seconds to prime the fuel system (this verifies ECU function). 
 

1) Create a new project (File > Project > New Project). 
 

 
 

2) Name the project. We recommend a descriptive name. In the example below “PimpXS_V11” is 

the name. Click the “Detect” button located to the right of the Firmware version. 
 

 
3) Your laptop will scan all connected ports and should find the ECU. If it gives you two options, 

select USB D2xx if using the supplied USB tuning cable. The image below should be displayed, 

then click Accept: 



 

 
 

4) Ensure your configuration settings match the image below, then click Ok: 
 

 
 

5) Ensure your communications settings match the image shown below, then click Next: 
 



 
 

6) Select your Dashboard type. For initial setup, the “MS3 Extra Analog Bar” dashboard displays 

most parameters you will want to monitor. Click Finish. Note that if you wish to display different 

gauges later, you can right click on any gauge and select a new gauge (change pulse width 2 to 

coolant temp for example).  
 

 
 

7) TunerStudio configuration is now complete. If you were unable to “detect” the ECU at this time, 

please consult the support forum HERE for assistance.  

http://stinger-performance.proboards.com/board/16/pimpx-pimpxs-tech-support-tuning


TunerStudio Dashboard Customization 

You can display any available gauge with any dashboard type so feel free to switch to whatever 

dashboard type you prefer and configure it with the gauges you need to watch once you’ve got it up and 

running.  

 

Supplied on the USB thumb drive are a few PiMPxs specific dashboards that use the PiMPxs logo and 

have all pertinent gauges shown. To load one of these PiMPxs dashboards, simply right click on the 

dashboard in TunerStudio and select (Load/Save > Load Dashboard) and navigate to the folder you 

saved all your USB thumb drive files to on your computer, go into the “TunerStudio Custom Dash-

Gauges” folder, then select the dash file of your choice. Below is an example dashboard we supply: 

 

 



Initial Configuration/Software Setup 

1) Connect the supplied tuning cable to the ECU and to your computer USB port. 

2) Ensure vehicle battery is fully charged. 

3) Open TunerStudio software, turn ignition key to the run position, DO NOT CRANK VEHICLE 

AT THIS TIME. You should hear fuel pump run for approximately 2 seconds and then shut off.  

4) Verify fuel rail is holding fuel pressure. This is to ensure no hardware problems exist grounding 

the injectors (and turning them on). 

5) Calibrate TPS and AFR table (wideband). If non Ford temperature sensors are used, also 

calibrate them at this time. See Appendix C for sensor calibration instructions. 

6) Your ignition settings should be set properly in your base file. It is recommended you check the 

ignition settings screen shots in Appendix F to verify your ignition settings match your desired 

setup. Only standard plug and play ignition options are covered in this quick start guide. If you 

want to use a non plug and play ignition setup, inquire on the support forum HERE for 

instruction on how to setup your ignition system. 

7) “Key Cycle.” This means turn the ignition off, then back to run (not start). 

8) Verify all sensors read correctly on TunerStudio dashboard. Verify TPS reads close to 0 (+/- 1%) 

when closed, and close to 100% when open. MAP should read very close to 100 kPa, unless 

located at high altitude. If you suspect incorrect MAP reading, check your favorite weather 

source for a current barometer reading. Many weather sources “normalize” this for altitude, so 

ensure yours is reporting actual barometric pressure.  

9) If all inputs read correctly, it is now time to attempt to crank the engine. Your ECU is shipped 

with a tuning file that will not fire the injectors so don’t be surprised when it doesn’t try to start. 

To make sure it doesn’t start, unplug your injector harness, or the individual injectors. Crank the 

engine over, and view the tachometer located on the TS display. You should see a reasonable 

(between 200 and 400 rpm) cranking speed, with “synced” displayed in one of the status boxes 

on the bottom of your screen. Plug your injectors/harness back in at this time. 

10) Now you need to verify that cranking timing is 10 degrees BTDC. Grab your timing light and put 

it on the #1 spark plug wire. DO NOT REMOVE SPOUT CONNECTOR. Crank the engine over 

and point the timing light at the crank pulley to view timing advance. If it is cranking at 

something other than exactly 10 degrees BTDC, you’ll need to loosen the distributor hold down 

bolt and rotate the distributor until it reads 10 degrees BTDC when cranking. Tighten down the 

distributor hold down bolt and then verify it is still 10 degrees when cranking. 

11) If “sync” and reasonable RPM was obtained above, you are now ready to load your base tune 

that was provided on the USB flash drive (In TunerStudio: File > Open Tune and then click on 

the base tune file in the USB drive’s “Base Tune” folder), and configure for your injectors, 

engine size, and fuel type (In TunerStudio: Basic/Load Settings > Engine and Sequential 

Settings > Required Fuel and enter your engine size, number of cylinders, injector flow rate, and 

Air-Fuel Ratio (14.7 for gasoline, other fuels see ***note below). Pay attention to the units for 

these values. It’s very common for people to enter the wrong info here because they don’t look at 

the units (they enter injector CC’s instead of lb/min or engine CC’s instead of cubic inches for 

instance). Be advised the “injector size” and “engine size” parameters seen in the Engine and 

Sequential Settings dialog are only used by the ECU for MAF calculations, which we don’t 

typically use. Feel free to enter them if you want but “Required Fuel” is the parameter that tells 

the ECU what to do with the injectors. Enter the actual values for your engine and injectors 

UNLESS you have a Batch Fire V8 with smaller than 60lb injectors. Batch V8’s Enter 

DOUBLE your actual injector size. In Step 13 below you’ll enter 4 injectors to make the 

fuel calculation come out correctly. This is due to required injector sequencing to also support 

sequential V8’s. 
 

***If running E85 or non-gasoline, you’ll need to set the AFR in the required fuel setting above that matches your 

fuel. E85 is ~9.86 depending on the exact ethanol percentage. You then need to follow the instructions in this 

support forum link that covers all of the details of running non-gasoline fuels (registration required to view): 

 Forum E85 Details  

http://stinger-performance.proboards.com/board/16/pimpx-pimpxs-tech-support-tuning
http://stinger-performance.proboards.com/thread/6076/project-setup-fuels-gasoline


12) Now let’s set the base tune to match your injector characteristics. (In TunerStudio > Fuel 

Settings > Injector Dead Time/PWM> Injector Dead Time (ms)), you need to set this value to 

match the type of injectors you are running. Enter dead time in the red box shown below: 
 

 

 

For factory 2.3T injectors, or Bosch & Delphi Low Imp, use 1.1. For TFX Low Imp, use 1.2. For 

factory V8 injectors use 0.9, for the High Imp Siemens Deka 4 Motron injectors we sell, use 0.8. If 

your injectors were supplied with dead time information such as our FID injectors, use your injector 

manufacturer data. More complete injector listing and additional details found in the 6th post of the 

FAQ here: PiMPxs Injector Characteristics 
 

13) Now change how the injectors fire by going to (Basic/Load Settings > Engine and Sequential 

Settings): 

---Batch fire 2.3T’s with 60lb or smaller injectors, set to 4 squirts/cycle - alternating. 

---Batch fire 2.3T’s with larger than 60lb injectors, set to 2 squirts/cycle - alternating or 1 

squirt/cycle - simultaneous.  

---Batch fire V8 60lb or smaller injectors, set to 4 squirts/cycle - alternating AND enter 4 

Injectors in Required Fuel above (Ideal Method, see Appendix F V8 Batch Fire on page 27) 

OR 

---Batch fire V8 60lb or smaller injectors, set to 2 squirts/cycle – simultaneous (actual injector 

size & number entered in Required Fuel Calculation above). 

---Batch fire V8 larger than 60lb injectors, set to 1 squirt – simultaneous.  

---Sequential fire (PiMPxs - any engine and injector size) is always 1 squirt – simultaneous.  
 

Following this step, if you’ve done everything outlined up to this point including entering 

your required fuel values covered in step 11 on the previous page, your engine is ready to 

run. 

http://stinger-performance.proboards.com/post/46145/thread


Initial Startup & Tuning 

1) Attempt to start the engine. Your engine will likely run at this point. You will most likely need to 

feather the throttle to keep it running at least initially until it warms up. You can adjust the 

throttle stop screw to increase idle speed to keep it running if necessary. Re-Calibrating TPS 

is required if you adjust the throttle screw. You’ll be tuning the IAC settings to set hot and cold 

idle speed later. If it is overly lean or rich, you’ll need to adjust the Fuel Table (Fuel Settings > 

Fuel VE Table 1) until the air/fuel ratio is between 12.5:1 and 14.5:1 initially. How to tune the 

PiMPxs is covered on our PiMPxs Tuning & Support Forum HERE.  
 

If you have any questions during the install, setup, initial tuning, etc., please 

use the Support Forum as it allows all of our Tech Support staff to answer 

your questions, unlike email which only goes to one person, or other 

forums/social media which goes to no one qualified to correctly answer your 

questions. You’ll need to register to view/use the PiMPxs section:  

PiMPxs Support Forum 
 

A continuation of this guide that covers the tuning of your PiMPxs after you’ve completed 

all of the setup covered in this Startup Guide is here:  

PiMPxs Tuning Guide 
 

2) Once running and before driving, you need to make sure the timing that is commanded on the 

laptop is the same as the actual timing number at the engine. In TunerStudio, go to (Ignition 

Settings> Ignition Options/Wheel Decoder> Fixed Advance and change it from "use table" to 

"fixed timing"). Then make sure "timing for fixed advance” is set to 20. This will lock the 

commanded timing at 20 degrees. DO NOT REMOVE SPOUT CONNECTOR as the intent is 

for the ECU to properly control timing which requires the spout to be connected. With the engine 

running, put timing light on the #1 plug wire and point it at the crank pulley. Verify that timing is 

at 20 degrees BTDC. If it isn't, rotate the distributor until the timing is 20 degrees BTDC. 

Tighten up the distributor hold down, verify timing is still 20 degrees, then go into the same 

location in TunerStudio and put it back to "use table". Verify timing is now advancing in order to 

match the timing table. Do NOT use the trigger offset settings to adjust timing as this effects 

your ability to retard timing for rev limit/launch control and can also have adverse effects 

on timing control if you get the trigger offset angle outside of the allowable range (0-15).  
 

Warning: All base tunes have a timing advance map optimized for 93 octane fuel. If 

running 91 octane, start by pulling 1-2 degrees from the entire timing advance table. 
 

3) If you have any issues tuning that you can’t seem to figure out, it is vital that you provide us with 

your most recent tune, as well as a datalog of the problem when posting the question(s) on our 

forum HERE. A datalog is a file that records all of the ECU’s inputs and outputs over time. 

When viewed with the MegaLogViewer software we provide you, it can be seen in graphical 

format and we can view the engine rpm, boost/vacuum, throttle position, air/fuel ratio, engine 

temp, air temp, and many other values at any given time during the datalogging session. This is 

extremely useful in diagnosing issues with the tune, faulty sensors, or other problems. We need 

both the tune and the log files to properly diagnose issues, not just one file or the other. 

4) If you have any tuning issues you want to ask about on the forum, providing us with a copy of 

your most recent tune allows us to compare that tune to the datalog to make sure they 

correspond, as well as make sure you haven’t changed any settings that are creating issues. To 

create a datalog in TunerStudio, simply go to (Data Logging > Start Logging) and it will ask you 

what you want to name the file, then click Save. If there is a certain time during the datalogging 

session that you’d like to point out (where a problem is occurring for instance), you can hit the 

spacebar when this occurs and it will create a timestamp that we can go directly at to view the 

http://stinger-performance.proboards.com/board/16/pimpx-pimpxs-tech-support-tuning
http://stinger-performance.proboards.com/board/16/pimpx-pimpxs-tech-support-tuning
http://stinger-performance.proboards.com/thread/5014/pimpx-pimpxs-tuning-guide-followup
http://stinger-performance.proboards.com/board/16/pimpx-pimpxs-tech-support-tuning


issue. When you are done datalogging and before shutting off the engine, go back to (Data 

Logging > Stop) and this will stop and save the file. More detailed instructions on how to create 

datalogs and upload them to the forum are available in the PiMPxs FAQ thread here:  

PiMPxs FAQ (Frequently Asked Questions)  

5) WARNING: For those with Turbo(s) or Superchargers, the base tune has an overboost fuel cut 

set to 23psi (260 kPa) for 4 cylinder engines and 15psi (204 kPa) for V8’s. This is for your safety 

during the tuning process. It’s a precautionary setting to keep boost from climbing any higher 

than desired before it is tuned. If you want to exceed the overboost value, you’ll need to raise the 

overboost limit by going to (Boost/VVT > Boost Control Settings > Overboost Protection) and 

then raising the maximum boost setting to a higher value. We’d advise not putting the overboost 

value more than 2-4psi above your desired max boost (depending on how stable your boost 

control is). This way it is far enough away from your desired max boost that it shouldn’t be hit 

unless something goes wrong, but is still low enough to hopefully prevent any engine damage if 

something does go wrong. The same holds true for those who only want to run low boost. It 

would be smart to lower the overboost protection value to a value closer to your desired max 

boost for safety reasons. 

6) Idle Control: Your base file is setup for closed loop idle speed control, with adaptive spark 

control. This means it uses both idle air solenoid, as well as spark timing to control idle speed to 

a target value. The target idle speed can be found in “Closed Loop Idle Target Curve”. IAC duty 

will initially be the values found in “Closed Loop Idle Initial Values.” The ECU initially uses 

these values when it begins to control idle speed. If idle speed is either well above or below 

target, alter this curve until it gets close. See support forum HERE and included MS3 guide on 

USB thumb drive for additional information and assistance. 

7) Speed/Position Input Circuits: Your ECU is equipped with 3 separate speed input circuits 

capable of working with most automotive sensors. These are tied to the “Crank”, “Cam”, and 

“VSS” (uses processor pin PT4) circuits. The “Crank” circuit is coupled to the factory distributor 

if jumper JP2 is installed. 

The speed inputs all function identically to one another. If it is desired to use a mag pickup 

sensor (voltage goes above and below 0), then connect both the positive and negative wires to 

the + and – circuit input. If a Hall Effect or Optical style sensor is used, then only connect a 

single wire (generally the +, although the – works also), to the ECU, leaving the other ECU wire 

“floating (disconnected)”. When only a single wire is connected, the threshold voltage is set to 

2.5v. 

All speed inputs also have pull up (to positive voltage) and pull down resistors on both + and - 

inputs. These are enabled with jumpers (see Jumper description table). These are required if your 

sensor output voltage doesn’t go solidly to ground or positive voltage on its own. 

Each circuit also has a voltage clamp resistor that is enabled via a jumper.  

Speed/Position Input jumpers are generally not required for plug and play operation, and are 

primarily used when adapting non plug and play ignition systems or speed sensors. Factory 

Ford VSS is supported plug and play without jumpers. 

8) TunerStudio “Search” : If you are having difficulty finding any setting mentioned in this guide, 

use the search bar located in the top right of your TunerStudio screen. Simply enter the 

feature/setting name in the search bar. 

9) Test Mode: Your ECU is equipped with an extremely useful diagnostics mode called “Output 

Test”. This feature allows you manual control of every ECU connected output. This includes 

injectors, ignition/coils, PWM outputs, relay outputs, and a special idle valve test. Operation of 

this diagnostics mode is covered in section 2.13.4 of the included MS3 Setup Guide.  

http://stinger-performance.proboards.com/thread/5013/pimpx-pimpxs-faq-frequently-asked
http://stinger-performance.proboards.com/board/16/pimpx-pimpxs-tech-support-tuning


Feature Explanation 

The descriptions below are general descriptions of optional features. Consult MS3 documentation 

included on your thumb drive for more detailed information. 

 

Cooling Fan control: This feature grounds a relay, which in this case controls one or two cooling fans. 

See Appendix E for screenshot and explanation of settings and wiring diagram. 

 

Table Switching: Table switching allows two sets of tables (fuel or spark) to be toggled via an external 

switch or software constraints. An example would be both a 100+ octane race fuel and 93 octane fuel 

timing map. This function is triggered through pin 24 at the ECU. 87-88 Turbo Coupes have a premium 

fuel switch wired to this pin from the factory so nothing needs to be changed. SVO’s use pin 30 for the 

premium fuel switch. In order to use the SVO premium fuel switch for table switching, move pin 30 to 

pin location 24. For applications without factory fuel switch, you’ll need to add a switch that grounds 

pin 24 when “on”. Table switching also has to be turned on and configured in TunerStudio to function. 

Settings will depend on what table you want to turn on and how you plan to use it so the settings will 

vary for each user. Provide us with this information on the PiMPxs forum HERE and we’ll inform you 

of proper settings for your particular usage. 

 

Launch Control: Allows the use of selectable rev limits when engaged (think drag racing 2-step). It can 

also be configured for “flat shifting.” This feature allows separate launch and shifting rev limits 

designed to maintain boost during shifts, triggered from one (usually the clutch) input. Generally the 

shifting rev limit is set to roughly match the RPM drop between shifts. 

 

Boost control: The ECU controls a solenoid that typically bleeds off wastegate pressure. This is 

triggered through pin 31 at the ECU. This can be configured either “open loop” (you manually adjust a 

solenoid duty cycle to achieve your targets), or “closed loop” (the ECU adjust duty to target a particular 

boost level). Both “open” and “closed” loop tables are engine speed and throttle position dependant. 

This is typically done with an aftermarket boost control solenoid such as the one we offer on our 

website.  

 

Nitrous Control: The ECU accepts an input (typically your arming switch interrupted through the 

typical WOT safety switch) that signals you wish to engage the nitrous. The PiMPxs ECU then becomes 

your “window switch” triggering your nitrous control relays when your desired engine speed and throttle 

position targets are reached. Two stages of nitrous control are available and can be triggered simply 

on/off, or progressively. This requires nitrous solenoids and required wiring of course.  

 

The ECU can also modify the fuel and spark when nitrous is enabled (normally add fuel/retard spark). 

There are fuel and spark settings for both nitrous stages. 

 

For additional info for any of these features not covered above or in the appendix, please post the 

question on our PiMPxs Tuning & Support Forum here: PiMPxs Support Forum 
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Appendix A 

 
Table 1 – EEC Pinout 

EEC Connector Pin Out - EEC Connector Used for ALL INSTALLATIONS 

Connector Pin Software Name/Function Jumpers Required: 

EEC Not 
Used 

EEC Pins  1,2,4,5,8,10,11,17,18,19, 23,27,28, 
32,33,34,35,38,39,41,44,45,48.49,51,53,54 NOT USED 

 

EEC 3 PT4 - VSS (Vehicle Speed) + No 

EEC 6 PT4 - VSS (Vehicle Speed) - No 

EEC 7 CLT - Coolant Temp No 

EEC 9 MAF Signal Return (Optional, Jumper Required) JP10 

EEC 12 MS3x INJ B (Injector #3, Jumper Required) JP8 

EEC 13 MS3x INJ G (Injector #4, Jumper Required) JP6 

EEC 14 MS3x INJ F (Injector #5, Jumper Required) JP5 

EEC 15 MS3x INJ E (Injector #6, Jumper Required) JP4 

EEC 16 OE IGN Ground (Terminates at Distributor) No 

EEC 20 GND No 

EEC 21 FIDLE (Fast Idle - Factory Idle Control Solenoid) No 

EEC 22 FP Relay No 

EEC 24 Table Switch (Jumper Required) JP11 

EEC 25 MAT (Manifold Air Temp) No 

EEC 26 5v Reference No 

EEC 29 EGO1 - O2 Sensor Primary (Passenger Side, Wideband) No 

EEC 30 Launch in - Provide Ground to Activate No 

EEC 31 Boost - Provides Ground for Boost Solenoid (Jumper Required) JP9 

EEC 36 SPOUT (Spark Output, Jumper Required) - "JS10" in Software JP19 

EEC 37 12v Power No 

EEC 40 GND No 

EEC 42 MS3x INJ C (Injector #7, Jumper Required) JP13 

EEC 43 EGO2 – Driver’s Side o2 Sensor (Optional, Jumper Required) JP12 

EEC 46 Sensor GND No 

EEC 47 TPS No 

EEC 50 External MAF - MAF Sensor Signal (Optional, Jumper Required) JP29 

EEC 52 MS3x INJ H (Injector 8, Jumper Required) - Also "High" Fan JP7 

EEC 55 Warm Up LED D15 - Used for Fan (Jumper Required) JP3 

EEC 56 Distributor Input (PIP, Jumper Required) JP2 

EEC 57 12v Power No 

EEC 58 MS3x INJ A (Injector 1, Jumper Required) JP14 (High Z Injectors) 

EEC 59 MS3x INJ D (Injector 2, Jumper Required) JP1   (High Z Injectors) 

EEC 60 GND No 

 



Table 2 – Expansion Port Pinout 

Expansion port can be used to control features not supported by the factory harness (not plug and play) 

and therefore require additional wiring to function. Expansion connector pigtail, labeled wires, pins, and 

connectors are available through our site for those who choose to use these options.  

 
Expansion Connector Pin Out.   
Connector, pins, & labeled wires available from our website both individually and assembled.   

Connector Pin Software Name/Function Description 

expansion 1 Spark/Coil A Logic Level (5v output) Ignition Output 

expansion 2 Spark/Coil B Logic Level (5v output) Ignition Output 

expansion 3 Spark/Coil C Logic Level (5v output) Ignition Output 

expansion 4 Spark/Coil D Logic Level (5v output) Ignition Output 

expansion 5 Spark/Coil E Logic Level (5v output) Ignition Output 

expansion 6 Spark/Coil F Logic Level (5v output) Ignition Output 

expansion 7 Spark/Coil G Logic Level (5v output) Ignition Output 

expansion 8 Spark/Coil H Logic Level (5v output) Ignition Output 

expansion 9 FLEX Flex Fuel Input - Also Generic Input 

expansion 10 MS3x Idle (F IDLE) Spare PWM Output 

expansion 11 Launch In (2-Step) Spare Input.  Ground to Activate 

expansion 12 Spare Analog (Spare ADC) Spare Analog Input - 0-5v 

expansion 13 IAC2 B (Stepper Driver) GM Style Idle Valve (needs 4 wires) 

expansion 14 N2O 1 (Nitrous Out 1) PWM Output 

expansion 15 N2O 2 (Nitrous Out 2) PWM Output 

expansion 16 Tacho (Tach Out) Tach Driver - Also PWM Output 

expansion 17 VVT (Spare PWM Output) PWM Output 

expansion 18 N2O In (Nitrous In - 12v Triggered Input) Input - 12v to Activate 

expansion 19 DataLog In (Ground Triggered Input) Spare Input - Ground to Activate 

expansion 20 IAC1 A (Stepper Driver) GM Style Idle Valve (Needs 4 wires) 

expansion 21 Cam Input + (Provide Switchable Pullup) Cam Sensor Input - Compatible with most 
sensor types.  See "Speed Input Guide" for 
detailed connection instructions. expansion 22 Cam Input - (VR2) 

expansion 23 Crank Input + (Provide Switchable Pullup) Crank Sensor Input - Compatible with most 
sensor types.  See "Speed Input Guide" for 
detailed connection instructions. expansion 24 Crank Input - (VR1) 

expansion 25 IAC1 B (Stepper Driver) GM Style Idle Valve (needs 4 wires) 

expansion 26 IAC2 A (Stepper Driver) GM Style Idle Valve (needs 4 wires) 

expansion 27 CAN H CAN Communications "High" 

expansion 28 CAN L CAN Communications "Low" 

expansion 29 TX Serial Transmit 

expansion 30 RX Serial Receive 

expansion 31 Sensor GND Sensor Ground - Tie Spare Analogs Here 

expansion 32 VREF - 5v Reference 5v Output - Use to Power Spare Analogs 

 

 

 

 

 

 



Jumper Explanation 

(ALL JUMPERS GO ON THE GREEN BOARD ONLY) 

Depending on your engine configuration, jumpers inside the PiMPxs ECU case need to be inserted in 

their proper location. This is so the PiMPxs knows what type of injectors you are running, how many 

cylinders the engine has, what kind of fueling strategy will be used, single or dual cooling fans, and 

whether you will use any optional features that require jumpers. We purposely don’t install these prior to 

shipment and instead include a bag of them so you’ll get comfortable with how this process works. You 

will need to double check you install the jumpers correctly prior to running the engine. You’ll need a 

pair of needle nose pliers to install the jumpers and a 5.5mm or 7/32” socket to remove the ECU case 

cover to access the jumpers. Common examples of required jumpers are listed 2 pages below. 

All jumpers near EEC connector will be perpendicular to the EEC connector when properly installed. 

See the image below for an example of a properly installed jumper: 
 

 
 

While most jumpers are simply two position jumpers to enable functions, some jumpers have 3 

positions. With 3 position jumpers, there is a small number “1” that identifies position #1. See the image 

below for an example of a 3 position jumper (JP25 in this case), with position #1 circled: 
 

 



Table 3 – Jumpers 

Jumper Number and Description 

Jumper  Description 

JP1 Injector 2/D  High Z Resistor Jumper 

JP2 Distributor Input Enable.  Install for All PNP Installs 

JP3 EEC Pin 55 Fan - Uses "WLED" for fan control 

JP4 Injector 6/E Enable 

JP5 Injector 5/F Enable 

JP6 Injector 4/G Enable 

JP7 Injector 8/H Enable - EEC Pin 52 - Also used for Turbo Coupe "High" Fan 

JP8 Injector 3/B Enable 

JP9 Boost Enable 

JP10 MAF Signal Return Enable 

JP11 Table Switch Enable 

JP12 EGO 2 / Driver’s Side O2 Enable 

JP13 Injector 7/C Enable 

JP14 Injector 1 /A High Z Resistor Jumper 

JP15 Spare Speed / VSS (-) Pullup/Pulldown Jumper (3 Position, See Speed Input Guide) 

JP16 Spare Speed / VSS Voltage Clamp Resistor (See Speed Input Guide) 

JP17 Spare Speed / VSS (+) Pullup/Pulldown Jumper (3 Position, See Speed Input Guide) 

JP18 Not assigned 

JP19 Distributor Spark Out - Jumper 2-1 for 5v Pullup, Jumper 2-3 for 12v Pullup 

JP20 Crank (-) Pullup/Pulldown Jumper (3 Position, See Speed Input Guide) 

JP21 Crank Voltage Clamp Resistor (See Speed Input Guide) 

JP22 Crank (+) Pullup/Pulldown Jumper (3 Position, See Speed Input Guide) 

JP23 Not assigned 

JP24 Tach Out - Jumper 2-1 for 5v Pullup , Jumper 2-3 for 12v Pullup 

JP25 Cam (-) Pullup/Pulldown Jumper (3 Position, See Speed Input Guide) 

JP26 Cam Voltage Clamp Resistor (See Speed Input Guide) 

JP27 Cam (+) Pullup/Pulldown Jumper (3 Position, See Speed Input Guide) 

JP28 Nitrous In Voltage Jumper - Install to Switch Input from 12v Triggered to Ground Triggered 

JP29 Baro/MAF selector - Jumper 2-1 for EEC MAF pin, Jumper 2-3 for Internal Barometer Sensor 

 

Injector Jumpers 

Your ECU has either 2 Injector Drivers (PiMPx, bank fired), or 8 Injector Drivers (PiMPxs, sequential).  

 

---4 Cylinder low impedance (originally bank fired, e.g. 2.3 Turbo): Install no injector jumpers. If 

jumpers are installed with low impedance injectors, damage to the injectors and ECU may result. 

 

---4 Cylinder high impedance (originally bank fired, e.g. 2.3 Turbo w/ high imp injectors): Install 

jumpers JP1 and JP14. 

 

---8 Cylinder high impedance (originally bank fired, e.g. Speed Density F-Series/Bronco/Non-Mustang): 

Install jumpers JP1 and JP14. 8 Cylinder low impedance injector bank fire is not supported. 

 

---8 Cylinder high impedance sequential (originally sequentially fired e.g. 5.0 EFI Mustang & MAF F-

Series): Install jumpers JP1, JP4, JP5, JP6, JP7, JP8, JP13, JP14, (8 injector jumpers total).  



Ignition Jumpers 

While your PiMPxs ECU can support additional ignition systems with extra hardware, in the “plug and 

play” configuration only TFI, DIS, EDIS, and CDI boxes (MSD, Mallory, etc.) are supported. Consult 

PiMPxs support forum HERE for non-plug and play ignition jumper requirements.  

 

Ignition Type: 

TFI- Install Jumpers JP2 & JP19 - position 2 to position 3.  

DIS- Install Jumpers JP2 & JP19 - position 2 to position 3.  

--(See Appendix D for additional DIS Wiring and Software Setting requirements) 

EDIS- Install Jumpers JP2 & JP19 - position 2 to position 3.  

CDI Box with TFI- Install Jumpers JP2 & JP19 - position 2 to position 3.  

 

If an installation kit was purchased with your CDI box, the box can be connected and configured as Ford 

TFI, but this setup will not allow for a spark cut rev limiter. See Appendix D for universal installation 

instructions for CDI ignition. 

 

Common Setup Examples for Mandatory Jumpers 

Here are some examples of common setups showing which jumpers are mandatory to run. Other 

jumpers will still be needed if you’re wanting to control anything that doesn’t affect engine operation 

(fan, table switching, boost control, etc.).  

 

--V8 Sequential with TFI (Distributor) or EDIS Ignition & High Impedance Injectors:  

JP1, JP2, JP4, JP5, JP6, JP7, JP8, JP13, JP14, JP19 (pins 2-3).  

 

--V8 Batch Fire with TFI (Distributor) or EDIS Ignition & High Impedance Injectors:  

JP1, JP2, JP14, JP19 (pins 2-3). 

 

--2.3 Turbo Batch Fire with TFI (Distributor) or DIS Ignition & High Impedance Injectors:  

JP1, JP2, JP14, JP19 (pins 2-3). 

 

--2.3 Turbo Batch Fire with TFI (Distributor) or DIS Ignition & Low Impedance Injectors:  

JP2, JP19 (pins 2-3). 

 

--2.3 Turbo Sequential with TFI (Distributor) or DIS Ignition & High Impedance Injectors:  

JP1, JP2, JP13, JP8, JP14, JP19 (pins 2-3). 

 

Additional jumpers are needed for optional functions, see jumper table above and descriptions 

below. 

 

Fan Jumpers 

The 87-88 Turbo Coupe wiring was chosen for fan outputs as it has factory dual fans. This means pin 55 

for primary/low fan, and pin 52 for high fan. Pin 52 is also used as an injector output on a V8, so high 

fan can not be used for a v8. Install jumper JP3 for Pin 55 fan control. Install jumper JP7 for Pin 52 Fan 

control. These are connected to the WLED (pin 55) and Injector H (pin 52).  

 

Table Switching Jumpers 

Table switching can be connected to the OE 87-88 Turbo Coupe premium fuel selector switch (pin 24 of 

EEC connector). To connect to the 87-88 Turbo Coupe premium switch, install jumper JP11 located 

near the EEC connector. Alternately, if your application does not have a factory switch, a standard 

toggle switch can be installed and connected to EEC pin 24 if jumper JP11 is installed. Connect one side 

of the switch to pin 24. Ground the other side of the switch 
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Boost Control Jumper 

Boost control requires a boost control solenoid such as our offering. Boost control solenoid can either be 

connected through the Turbo Coupe EEC BCS control pin, or through the expansion connector. In order 

to enable boost control, install the boost control jumper labeled JP9 located near the EEC connector. 

ECU uses 87-88 Turbo Coupe BCS pin 31. If vehicle originally came equipped with a P series ECU (83-

86 Turbo Coupe, Mustang, any year XR4Ti) and hasn’t been swapped for an LA3, move the pin located 

at position 32 to position 31 if you want to use PiMPxs controlled boost control. For applications not 

factory boosted, either add wire to pin 31, or use expansion connector for boost control activation.  

 

Clutch Input (for Launch/Flatshift/2-step) 

The clutch input is triggered by grounding the clutch input pin. This is brought in via the factory EEC 

neutral input (already connected to the clutch switch) which is EEC pin 30. 

 

Nitrous Control 

Nitrous control is supported only via the expansion connector. 12v Input, Ground Output, 2 Stage. 

 
PWM Output 

Boost Control, Nitrous 1, Nitrous 2, VVT, and IDLE are PWM (pulse width modulation) outputs. These 

outputs can be used as simple “on/off” relay drivers, or they can be used for generic PWM control. 

 

PWM control effectively means they can be switched on and off at relatively high speed, allowing them 

“variable” control of things like solenoids, pumps, and fans. Two stages of progressive nitrous/water 

injection control are available using these outputs. Return-less fuel systems can also be controlled with 

these outputs. If the connected load pulls less than 2 amps or so, they can be directly connected. Above 2 

amps a solid state relay should be used (electronic relay with no moving parts that can be controlled at 

high speed). Please consult the support forum HERE for assistance with your control questions. 

 

Any PWM output can be assigned any function requiring one. As an example, the “Boost Control” pin is 

only brought out on the EEC connector, as many turbo ECM’s use this. If you wish to use boost control, 

but your wiring harness does not have a wire in this location (and you do not want to put one there) you 

can assign another PWM pin for use as boost control (VVT pin located on expansion connector would 

be good example). 

 

It’s obviously easier to track features mentally if outputs are used for their “named” function (Boost 

Control for boost control), but they are universal and configurable so ultimately this is up to you. 

 

Digital Inputs 

Table Switch, Datalog In, Nitrous In, and Launch In are all “generic” digital inputs. Nitrous In is 

somewhat unique in that it is triggered by 12v, while the others are triggered by being grounded. Any 

Digital input can be assigned any function requiring a digital input. 

 

An example is Table Switch. The Table Switch input is tied to EEC pin 24, and is not brought out on the 

expansion connector. If your application does not have a wire in this location (or you do not want to 

install one), you can use another digital input present at the expansion connector for Table Switching. 

 

It obviously is easier to track features mentally if outputs are used for their “named” function (Table 

Switch for table switching), but they are universal and configurable so ultimately this is up to you. 
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Appendix B 

 
ACT/IAT Sensor Installation 

For cars not equipped with an air charge temperature sensor from the factory, you’ll need to install one 

for use with the PiMPxs. 87-88 Turbo Coupe, dual plug Mustangs/Rangers, and 87-95 5.0 Mustangs 

came with an ACT sensor. SVO, Turbo GT, 83-86 Turbo Coupe, and Merkur XR4Ti did not come with 

an ACT sensor. We sell the ACT sensor pigtail connector to aid in this installation. The sensor is 

available from your local parts store; just request one for a 1988 Thunderbird Turbo Coupe.  

 

The ACT needs to be wired into the factory ECU connector at pin 25 for the signal wire and pin 46 for 

the ground. Factory ACT sensor equipped cars (V8’s, 87-88 TC) are already wired this way.  

For VAM equipped cars that aren’t rewired for an LA3 ECU and already have an ACT*, the easiest way 

to do this is to wire the ACT through the VAM wiring plug VAT wire (light green/purple stripe in the 

location shown in the diagram below) which is already in pin location 25 in the factory ECU connector. 

Then wire the ground side of the ACT to the black VAM wire. Install the ACT sensor in the factory 

location in the intake manifold or in the intercooler tubing after the intercooler.  

Another easy option is to use the no longer utilized knock sensor wiring for the ACT (since it’s in a 

similar location to where the ACT will be installed). To do this you just cut the knock sensor connect off 

the harness and attach the ACT connector to the old knock sensor wires. Then move the knock sensor 

wire at the ECU connector from pin location 23 to pin location 25. 

 

*Note that some people rewire their vehicle to run an LA3 or equivalent ECU (LB2, LB3, 8UA) and 

never install an ACT sensor. If your car didn’t come with an LA3 or equivalent but was wired for and 

running one before installation of the PiMPxs, you’ll need to verify that an ACT sensor was installed. If 

it wasn’t, you’ll need to add one that is wired to pin 25 using one of the options above. Note that if you 

use the VAT wire method, the VAT in 87-88 TC’s is connected to pin 43 so you’d need to move this pin 

from 43 to location 25 once it’s connected to your new ACT sensor.  

 

Ultimately you need the ACT wire running to pin 25 at the ECU connector and pin 46 for the ACT 

ground wire, no matter what method you use to get to this point. 

 



Appendix C 

 
TunerStudio Sensor Calibration 

TPS Calibration: With the ignition turned on select (Tools > Calibrate TPS). With throttle closed, click 

Closed throttle ADC count “Get Current” button. Now press the throttle pedal all the way to the floor 

and click Full throttle ADC count “Get Current” button. Once the values are set, click close. 

  

 
 

Wideband Sensor Calibration: select (Tools > Calibrate AFR Table) and then select the type of 

wideband sensor you are using. To ensure accurate calibration so your AFR reading in TunerStudio 

matches your wideband gauge, rather than selecting a pre-defined wideband option, instead select 

“Custom Linear WB” and enter the values in the table that match the settings your controller is using 

(found in the wideband instructions, listed as voltage vs AFR). Click “Write to Controller”. 

 

 
 



If you are using any non-Ford sensors (namely ACT/IAT or coolant temp), you’ll need to calibrate them. 

Select (Tools > Calibrate Thermistor Tables). Most common options are available in the drop down 

menus. Click “Write to Controller” to finish the calibration. 

 

 
 



Appendix D 
 

Universal Installation Instructions for factory 2.3 Dual Plug DIS Ignition (NOT EDIS). 

For those with 91-93 dual plug 2.3 Mustangs or 89-94 dual plug Rangers who don’t want to run the 2.3 

Turbo ignition system with a distributor and single coil (and the wiring modifications required) and 

would rather run the factory dual plug DIS ignition, you’ll need to move one wire and make some 

software setting changes to make it work.  

Start by going to (Ignition Settings > Ignition Options/Wheel Decoder) in TunerStudio and change the 

settings so they match the figure below and then click “Burn”: 

 

 
 

There is one wire for the DIS module that needs to be grounded only after the engine is started to trigger 

the second coil to start firing. To make the PiMPxs control this, we’ll be using one of the fan control 

outputs (only one is required to trigger the fan).  

 

Now you need to move Pin 32 at the ECU connector to the location of Pin 52 or Pin 55. If there is 

currently a wire in the Pin 52 location, check Pin 55. If either of them is empty, move Pin 32 to that 

empty location. If neither is empty, remove Pin 52 and replace it with Pin 32. When you remove Pin 52, 

put tape over the end of it so it doesn’t short on anything in the future.  

 

 



If you replaced Pin 52, install the JP7 jumper. If you replaced pin 55, install the JP3 jumper. You will 

then need to go to (Advanced Engine > Programmable On/Off Outputs 1). If you used pin 52, select the 

Output Port labeled “PA7 - Inj H”. If you used pin 55, select the Port labeled “PM5 - Warmup LED”. 

Then make the “Port Settings” and “Conditions” match the figure below and click “Burn”: 

 

 
**Note whichever fan pin and fan jumper you use for this DIS function (Pin 52 with the JP7 jumper or Pin 55 with the JP3 

jumper), you’ll need to use the other pin location and jumper for your actual fan control as you can’t control two different 

outputs with one wire and jumper.  

***Shown above is Pin 52 (PA7-Inj H) used for DIS function and Pin 55 (PM5-Warmup LED) used to control the fan. If 

using Pin 55 for DIS function and Pin 52 for Fan, swap the settings so PM5 looks like the top image and PA7 looks like the 

bottom image. If your fan runs opposite of how it should, switch the “Power On Value” and “Active Value” for the fan port 

settings. These will vary depending on whether you’re using the factory IRCM or a universal relay.  
 

Now you need to verify that cranking timing is 10 degrees BTDC. Grab your timing light and put it on 

the #1 spark plug wire. DO NOT REMOVE SPOUT. Crank engine over and point timing light at crank 

pulley to view timing advance. If it is cranking at something other than exactly 10 degrees BTDC, you’ll 

need to adjust the “Trigger Offset” value until it reads 10 degrees BTDC when cranking. This setting is 

at (Ignition Settings > Ignition Options/Wheel Decoder > Trigger Angle/Offset) in TunerStudio. Be sure 

to click “Burn” to send the changed settings to the PiMPxs before re-checking the cranking timing.  

 

 



Once you get through all of this Startup Guide and the engine is running, you’ll need to verify that the 

Output Port configured above is working as intended. To do this, put timing light on spark plug wire 

connected to the front ignition coil and verify spark. Then do the same for a plug wire connected to the 

rear coil. If both coils are firing, you’re good to go. If only one is firing, either the Output Port settings 

above haven’t been copied exactly (typically one of the “>” after the rpm condition is backwards (<), 

“enabled” is not checked, or the power on and trigger values are backwards. If this isn’t the case, verify 

the wiring for pin 52 or pin 55 is correct. If that appears correct, ask the question on our Support Forum 

HERE and we’ll diagnose it and figure out what’s causing the issue.  

 

Once running and before driving, you need to make sure the timing while running matches what the 

PiMPxs is commanding. This step is absolutely vital to prevent engine damage so do not skip it. This 

process serves the same purpose as when you check cranking timing above except now we’re double 

checking this while running. In TunerStudio, go to (Ignition Settings > Ignition Options/Wheel Decoder 

> Fixed Advance) and change it from "use table" to "fixed timing". Make sure "timing for fixed 

advance” is set to 20. This will lock the commanded timing at 20 degrees. DO NOT REMOVE SPOUT. 

With the engine running, put timing light on #1 plug wire and point it at crank pulley. Verify timing is 

20 degrees BTDC. If not, you’ll need to adjust the “Trigger Offset” value until it reads 20 degrees, then 

go to (Ignition Settings> Ignition Options/Wheel Decoder > Fixed Advance) and put it back to "use 

table". Verify timing is now changing as the rpm increases by using timing light on #1 plug wire and rev 

the engine a bit.  

 

If you’re using dual plug cylinder head, you’ll need to pull 3 degrees out of entire timing map since the 

dual plug configuration creates a quicker burn. To do this, go to (Ignition Settings > Ignition Table1), 

highlight entire table by clicking and dragging across it, or simply hitting “A” key on your keyboard 

while holding down “CTRL” key. Once highlighted, click “-“ button in the top right corner of the table 

and decrease selected cells by 3. You should see all of the values in the table decrease by 3 at this point. 

Now click Burn. 
 

Universal Installation Instructions for CDI Ignition. 

Wire the MSD box as if you’re using the factory ECU. Install the jumper for TFI if you haven’t already 

done so. If you have an MSD tach adapter, do not use it with the PiMPxs or damage to the ECU may 

result. 
 

*Note the diagram below is for MSD ignitions. If using another brand, wire colors may be different so you’ll need to follow 

the instructions for that particular CDI ignition box. 
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Appendix E 

 
Fan Control Wiring and Configuration 

For vehicles other than the 87-88 Turbo Coupe, to use PiMPxs fan control you’ll have to modify the fan 

wiring. The diagram below shows how it needs to be wired. You’ll need a 5 pin relay and a 20 amp 

inline fuse as shown below. Note that there are two different wire sizes. The large 10 gauge wire carries 

a large amount of current to the fan. The smaller 18 gauge wires simply trigger the relay to turn the fan 

on. (5.0/V8: Use pin 55 instead of pin 52, otherwise the wiring is the same). 

 
You’ll also have to configure TunerStudio to turn on fan control and configure when it turns on and 

shuts off. Open the fan control dialog in TunerStudio (Advanced Engine > Programmable On/Off 

Outputs 1) and then select the Output Port: 

2.3/2.3T: Injector H wired to Pin 52 & using the JP7 Jumper  

5.0/V8: Warmup LED wired to Pin 55 & using the JP3 Jumper 

Then adjust all of the Port Settings & Conditions to match the pictures. Pay close attention to the “>” 

next to coolant and rpm. These conditions mean that the fan will turn on at temps greater than 195 

degrees if the engine is running at greater than 500 rpm. Don’t trigger the fan to come on below 195 

degrees unless you have a lower temp thermostat. 

 

Images below show settings for the factory 87-88 Turbo Coupe High/Low fans. In this application, 

grounding the “low fan” actually turns the fan off. This is why the “power on” value is set to “On” and 

the active value is set to “Off”. With a universal style relay like shown above you will set the Power On 

value to “Off” and the active value to “On” as shown in the image on the right (85-93 V8 Mustangs use 

WLED not Inj H but otherwise use the settings on the right). 

 

 87-88 TC Low Fan/Ground=Fan Off:                            V8 Fan & TC High Fan/Ground=Fan On: 

 



Appendix F 

V8 Sequential TFI Ignition Settings 

 
 

Non Sequential/Batch Fire TFI Ignition Settings 

 



EDIS Ignition Settings 

 
 

 

V8 Batch Fire General Settings Setup 

 

 



DO NOT IGNORE OR ENGINE DAMAGE COULD OCCUR! 

 

How To Tune Your PiMPxs: 

A continuation of this guide that covers the tuning of your PiMPxs after you’ve completed all of the 

setup covered in this Startup Guide is here: PiMPxs Tuning Guide 

 

When modifying your tune, be sure to save the changes (In TunerStudio: File > Save Tune As) and 

then rename the file something other than the original name. This is so you can revert back to a 

previous tune if you find the changes you’ve been making have made it run worse, not better. 

Furthermore, it often helps to name the file for the changes you’ve made so you can look at the tune list 

and tell what is different compared to other tunes you’ve made. In example would be if your original file 

name is basetune.msq and you change the rev limiter settings, when you save the file, name it basetune-

revlimit.msq or something similar. 

 

Last but not least, don’t change settings in TunerStudio that you don’t understand. Engine damage 

may result from such activity. If you want, you can hide the advanced features to reduce the 

temptation to change settings you shouldn’t mess with as a beginner (In TunerStudio: Basic Setup > 

Basic/Advanced user and select how much you want to limit yourself). You can always change it back to 

advanced once you are more comfortable with the software and tuning process at a later date. 

 

To prevent damage to your ECU, always be sure to turn off the key and unhook the battery 

negative before messing with wiring around the ECU, moving pins, etc. If you don’t do this and you 

somehow hit the ECU case with 12v or 5v power either by hooking up the battery wires backwards, or 

directly touching a live power wire to the case, or connecting a power wire in the harness to ground, it 

will instantly fry both circuit boards inside the ECU. This sort of failure is only possible with this sort of 

mistake and is an expensive repair not covered by warranty.  

 

Liability & Restrictions 

Stinger Performance Engineering LLC and all related parties involved in assembly, repair, support, or 

any other action involving the PiMPx/PiMPxs Engine Management System are not responsible for 

damages resulting from the use or misuse of the PiMPx/PiMPxs Engine Management System. Failure to 

follow instructions provided and/or failure to properly tune your engine may result in engine damage. 

Any damage caused either directly or indirectly by attempting to tune your engine on the street including 

accidents or issues with law enforcement is your responsibility, not Stinger Performance Engineering 

LLC’s.  

 

The base tune provided with your ECU is only intended to get the engine running. It is not safe to 

run/drive the engine at wide open throttle before the base tune has been configured and tuned for the 

engine by the end user. 

 

Emission controlled cars may not legally use any aftermarket ECU on the public. Stinger Performance 

Engineering LLC and all related parties are not responsible for failed emissions testing or any penalties 

resulting from using the PiMPx/PiMPxs ECU under any circumstances. For this reason, the 

PiMPx/PiMPxs is sold for vehicles that will not be used on public roads and are therefore exempt from 

emissions testing.  

 

 

http://stinger-performance.proboards.com/thread/5014/pimpx-pimpxs-tuning-guide-followup

